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Quick Start Guide  

  

1. Install and register your new software...  

Installation and Setup of GemStone 

Registering your new software 

  

2. Take a quick look at the user interface and terminology...  

GemStone User Interface 

The GemStone Workspace 

What is a Project? 

The Project Library 

What is a Template Document? 

Saving and Opening 

Users and Groups 

  

3. Try out a tutorial or two...  

Analyzing Files with an Existing Project 

  

The Develop tutorials for creating your own projec ts: 

Starting a New Project from Scratch 

Adding Cell Types to the Project 

Analyzing Subsets 

Exploring with Cen-se' 

Additional Exercises 
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Finishing the Project 

Stain Assessment 

  

Further reading  

When you have a chance, review the Reference sections. 

Reference 
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License and Warranty  

  

License Agreement  

Copyright laws of the United States and international treaty protect this software. Verity 
Software House provides this software (the "Software") under the following conditions:  

Software is intended to be installed and used on one computer. An additional computer 
license is required for each additional installation. 

Network versions of software require one serial number for each simultaneous use. Network 
versions are intended for installation and use on a local area network; other uses are not 
supported. 

Backups of the software must be used only for archival purposes. 

Duplication of the manual is strictly prohibited without the expressed written permission of 
the copyright holder.  

If you transfer the use of this software to another party, that part y must accept the terms of 
this agreement, and you must transfer all copies of the software or destroy them.  

Your license to use this software will terminate if you are found to be in violation of this 
agreement. 

The laws of the State of Maine and the United States of America govern this license. 

  

Limited Warranty  

Verity Software House (VSH) warrants the physical media and the physical documentation, if 
included, to be free of defects in materials and workmanship for a period of 30 days from 
date of purchase. If VSH receives notice of defects in materials or workmanship within the 
warranty period, VSH will replace the defective media or documentation. 

VSH makes no other warranties, either expressed or implied, with respect to this manual or 
with respect to the software described in this manual, its quality, performance, 
merchantability, or fitness for any particular purpose. VSH software is licensed "as is". The 
entire risk as to its quality and performance is with the buyer. Should the software prove 
defective following their purchase, the buyer (and not VSH, its distributor, or its retailer) 
assumes the entire cost of all necessary servicing, repair, or correction and any incidental or 
consequential damages. In no event will VSH be liable for direct, indirect, incidental, or 
consequential damages resulting from any defect in the software, even if VSH has been 
advised of the possibility of such damages. Some states do not allow the exclusion or 
limitation of implied warranties or liability for incidental or c onsequential damages, so some 
of the above limitations or exclusions may not apply to you.  
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Latest Versions  

  

To find the latest versions for GemStone and the documentation, visit the Verity Software 
House web site at www.vsh.com. This site provides a complete version of the latest revision 
of the online documentation, patches, and technical support information for the program.  

You can also email us at verity@vsh.com to determine whether or not you have the lates t 
version. Please include the version that appears on the start -up dialog box, and the file date 
for the program with your email.  

The software also has a Check for Updates command in the Help menu. Use this command 
periodically to see if there are updates for your software. The command can download and 
install updates that are available, if you have administrative rights to your computer.  

https://www.vsh.com/
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New Features in  GemStone  

  

GemStone 2.0 is a totally redesigned application. While it is based on the same Probability 
State Modeling engine introduced with GemStone 1.0, the user interface and workflows are 
entirely different.  

And you will love the changes! 
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System Requirements  

  

NOTE: Your software will only run on the operating system you select  at the time of 
purchase.  

  

Minim um System Configurations  

If you purchased a Windows version:   
Windows 7, Windows 10 or greater, 3.40GHz CPU or better, 8GB RAM or greater, 8 or more 
logical processors, with 750MB free disk space for program files.   

  

If you purchased a Mac version:   
macOS 10.12 or greater, 3.40GHz CPU or better, 8GB RAM or greater, with 750MB free disk 
space for program files.   

  

Optimal Configurations  

Faster CPUs with more cores, high-speed SSD drives, and greater RAM will improve 
performance. 
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Installation  and Setup of GemStone  

  

IMPORTANT NOTES:  

¶ Your software will only run on the operating system you select  at the time of 
purchase.  

¶ Stand -alo ne versions of the program are designed to be  installed and 
registered on a single computer . 

¶ You must have administrative rights to the computer during installation and 
registration of the software. After registration, the program can be run by users with 
restricted access to the computer, as long as the program is installed in a location 
where users have read/write permissions. 

¶ You will need to register the software with Verity Software House in order to unlock 
the program on the computer. This can be done  using the online registration process 
or by contacting technical support.  

¶ If your program is an update version, you  will need the serial number for the previous 
version to register and unlock the software.  

¶ If your program is an additional computer license , you will need the serial number for 
the primary license to register and unlock the software.  

  

Windows Version  

Ins tallation  

¶ Log on to your computer with an account that has Administrator privileges. You must 
have administrative rights during installation . 

¶ If you downloaded the software, extract the installation files from the download into a 
temporary folder. If you h ave an installation CD, insert the program CD into the CD-ROM 
drive. 

¶ Run the program named GemStoneSetup.exe . Follow the directions on the screen to 
complete the installation. 

¶ See the section on registering your software for information on how to register your 
software. 

Using the software  

¶ Log on to your computer with your own user account. This should be the account that 
you normally use on the computer.  

¶ Open the Start menu and navigate to the Verity folder. Choose GemStone 2.0 . 

  

Mac OS Version  
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Installation  

¶ Log on to your computer with an account that has Administrator privileges.  You must 
have administrative rights during installation.  

¶ The installer is distributed as a disk image, or "DMG" file. Double-click the DMG file to 
mount and open the disk.  

¶ A Finder window will display program icons and instructions for how to install the 
program. Follow those directions to complete the installation.  

¶ See the section on registering your software for information on how to register your 
software. 

Using the software  

¶ Log on to your computer with your own user account. T his should be the account that 
you normally use on the computer.  

¶ In Finder, navigate to the Applications folder.  
¶ If there is  a GemStone  shortcut in the Applications folder, double -click it to start the 

program. 
¶ If there is no GemStone shortcut, open the GemStone 2.0  folder, and then the 

Application subfolder. Double-click the GemStone 2.0  application icon. 
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Registering your new software  

  

Why You Should Register  

Registration is a key step in setting up the software to run on your computer. In fact, your 
software will not be fully functional until you register . Here's why. 

This version of the program uses software security, which requires you to register your 
software in order to receive an Unlock Code  to make the program fully functional. An 
unregistered installation will be fully functional for 30 -days, and then become a "trial version" 
with limited functionality until it is registered.  

Of course, registration is useful for other reasons, too. We can inform you of bug fixes and 
updates, and provide you with bet ter technical support. 
  

How to Register  

When you start the program for the first time, it will automatically start the Registration 
Wizard. You can access this dialog at any time by clicking the Registration button on the 
dialog box that is displayed when the program starts up.  
  

 
  
Click the Next  button to begin the registration process.  
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The wizard will ask how you want to register the program. Select  the appropriate option and 
click Next.  
  

 
  
Then next step in the wizard shows some information about the program. There are 3 fields 
that you need to fill in for this step: Serial #, CD Key, and Your Email. You can also enter or 
edit the Computer Name field to identify your computer.  
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The Serial number and CD Key can be found on the outside of the pro gram box or in email if 
the program was provided to you by download. Enter these exactly as they appear; they are 
case-sensitive. If you have lost or misplaced the Serial number or CD Key, contact Verity 
technical support at tech@vsh.com or (207) 729 6767. 
For the Email field, make sure to enter your valid email address. Otherwise, you may not 
receive the Unlock Code and the program will not be fully functiona l. 
Click Next  to continue the registration process.  
  
If you have not yet created a user account on  vsh.com, a user account wizard is displayed. 
This step only appears if you have not yet created a user account. 
Fill in all fields on the form and click Next . 

 
  
If you have more than one user account at vsh.com, you will be presented with another step. 
This step only appears if you have more than one account. 
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Choose the web account that you want to use for registration, and then click Next . 
  
At this point, the program will request an unlock code from the registration server at 
vsh.com. If successful, you will see the confirmation step and the Unlock Code for  your 
computer. 
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You can print the registration information by clicking the Print  button. Click Finish  to close 
the wizard and continue working with the program  
  
If there was a problem with the registration, an informative message will explain the pr oblem 
and steps to take to correct it.  
  
Once you have completed the registration successfully, the program will be fully functional.  
  
  

If the registration wizard cannot connect to vsh.com  

Sometimes firewalls can prevent the registration wizard from conn ecting to vsh.com. In this 
case, you can try registering with your browser. Choose the second option in the list and click 
Next  to launch your browser with the correct registration information.  
  

 
  
Follow instructions on screen to complete the process. 
  

To register your software using email  

The registration wizard can help you send email to Verity Software House with your 
registration information. Choose the third option in the list and click Next  to create an email 
message. 
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Follow instructions on screen to complete the process. 
  

To register your software using another computer...  

When the installation computer does not have internet access but another computer does, 
you can use the fourth  option in the list and click Next  to begin the pr ocess. 
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On the installation computer, write down the Computer ID displayed in the 
Register Software dialog . 

Next, go to the computer that has Internet access, launch a browser, and navigate to 
www.vsh.com. 

Click the Register Software  link. 

If you already have a web account, login with your user name and password.  If you do not 
have a web account, create a new account that will be associated with this registrati on. 

After you login, the Software Registration  page will be displayed on the web site.  Fill in 
the information in the form on this page to register the product. If you are registering an 
update version, you will need the serial number of the previous vers ion to complete the 
registration. If you are registering an additional user license, you will need the serial number 
of another copy of the program that is registered to your institution.  

Getting an Unlock Code is a two-step process. First, you fill in and  submit the registration 
form on the web site. This sends a registration request is sent to Verity. Your Unlock Code is 
then emailed to you, so make sure you provide a valid email address. 

When you receive your Unlock Code via email, paste or type it into the Unlock Code field in 
the Registration dialog box on the installation computer. When possible, use Copy and Paste 
to do this, to ensure that the characters are correct. Then click the OK button.  

Your program will become fully functional once the Unlock Code is entered correctly. 

  

If you do not have Internet access  

If you do not have access to the Internet, you can send the registration information below to 
Verity Software House by fax, mail, or telephone. Our technical support staff can register the 
software for you with the information you provide, and supply you with the Unlock Code to 
enter into the Registration Wizard. 

Here is the information we need. You can print this page and fill it in.  

These fields are found in the Registration dialog box. 

Program Name: 
Program Version: 
Computer ID: 
Serial number: 
CD Key: 

User Information 

Name: 
Institution:  
Address: 
City: 
State/Province: 
Zip/Postal Code: 
Country: 
Phone: 

https://www.vsh.com/
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Fax: 
Email: 

Our technicians will use the information below to create a web user account for  you on our 
web site. 

Name to use on VSH web: 
Password to use on VSH web: 
A question we can ask to verify who you are:  
The answer to the question to verify who you are:  

If you are updating from a previous version, you will need to supply the serial number of the 
previous version. 

Serial Number of previous version: 
  

Contact Verity Software House  

Verity Software House 
PO Box 247, Topsham, ME 04086 
USA 
 
Email: verity@vsh.com 
Web: www.vsh.com 
Phone:  (207) 729 6767 
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GemStone Terminology  

GemStone User Interface  

  

When GemStone starts-up, the main window is comprised of a ribbon bar at the top, a batch 
list on the left, and a report tab that contains tabs for each page in a report.  

 

  

The ribbon bar contains most of the commands that you will use.  The commands are divided 
into a series of ribbon tabs: File tab, Home tab, Insert tab, Options tab, Develop tab, and the 
Help tab.  Some tabs are only visible when the Develop option is enabled. 

  

Develop Mode  
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In Develop mode, additional elements are displayed: 

 

  

Additional ribbon tabs are displayed in Develop mode.  Batch commands determine what 
actions are performed on files in the batch.  Additional tabs appear at the bottom of the 
window to select FCS File, Cell Types, and Maps view.  With the Cell types view selected, a 
tab is shown for each cell type defined in the model templ ate. 
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GemStone Us er Interface  

  

When GemStone starts-up, the main window is comprised of a ribbon bar at the top, a batch 
list on the left, and a report tab that contai ns tabs for each page in a report.  

 

  

The ribbon bar contains most of the commands that you will use.  The commands are divided 
into a series of ribbon tabs: File tab, Home tab, Insert tab , Options tab, Develop tab, and the 
Help tab.  Some tabs are only visible when the Develop option is enabled. 

  

Develop Mode  

In Develop mode, additional elements are displayed: 
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Additional ribbon tabs are displayed in Develop mode.  Batch commands determine what 
actions are performed on files in the batch.  Additional tabs appear at the bottom of the 
window to select FCS File, Cell Types, and Maps view.  With the Cell types view selected, a 
tab is shown for each cell type defined in the model template.  
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The GemStone Workspace  

  

The GemStone workspace is a folder on disk where the software is installed.  The folder 
contains key components of the program in sub-folders that store the progra m itself, the user 
guide, the Project library, and other important parts of the software.  
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What is a Project?  

  

The term "Project" in GemStone refers to collection of files that d etermine an analysis 
approach. A Project includes one or more model templates that are used to analyze FCS 
files.  It includes one or more batch scripts that determine how to load FCS files and model 
templates, what operations to perform on the FCS files, and the outputs of the analysis such 
as PDF files and databases.  A Project contains the FCS files added to it, and the output files 
it generates. 

Projects provide a simple way to design an analysis strategy and to manage the related 
files.  On disk, a Project is organized as a set of folders and files. 
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Project  

The Project Library  

  

The Project Library is part of the GemStone Workspace that contains the Projects that can be 
used for analysis, including those that you create.  Each Project is a folder which contains 
additional folders of information.  

The example below shows Projects that have been created: 16 Color Demo, Exp 1 10-Jan-
2018, and Exp 2 17-Jan-2018.  The folder structure of one of the Proj ects is also shown. 
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What is a Template Doc ument?  

  

A template document contains the cell type definitions, expression profiles, report design, 
and objects on the cell type canvas. It is the underpinning  of the analysis system - the 
Probability State Model.  This component of the software is only accessible in Develop mode. 

  

A template document defines a set of cell types.  Each cell type is defined by a set of 
expression profiles for the key markers of the cell type.  For example, a CD8 cell type is 
typically defined with expression profiles for CD3, CD66b, CD19, CD8, CD4, and other 
markers.  The cell types can include staging related to the cell t ype, as well as graphical 
elements like 1P and 2P plots, overlays, and more. 
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Saving and Opening  

  

GemStone has many different types of items that can be saved and opened.  Here's an 
explanation of the primary open and save operations that you will encounte r in the software.  

  

The Home tab, Develop tab, and File tab of the ribbon are used for saving and opening:  

 

  

 

  

Projects  

When you open or save a Project, the program opens or saves the batch commands and 
database fields for the method.  The batch commands determine what template documents 
are used, what kinds of out put to save (PDF, analysis documents, etc.), and what to print.  

  

Command  
Where 
Is It?  

Function  

 

  

File 
menu,  
Develop 
tab 

Save the current method in the 
Project Library  folder.  In 
Develop mode, it will also prompt 
you to save the template 
document. 

 

  

Home 
tab 

This dropdown list displays all of 
the methods in the Project 
Library .  It opens the selected 
method. 
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File 
menu 

The Open Project command 
allows a method to be opened 
from outside of the Project 
Library .  

  

Analysi s Documents  

An Analysis document stores the analysis of an FCS file with a template document. Typically, 
this is saved automatically in the Fitted Models folder by the batch commands.  The user can 
also manually save and open analysis documents for review. 

  

Command  
Where Is 
It?  

Function  

 
  

Home tab 
Saves the current analyzed document to the current 
method's Fitted Models folder. 

 
  

Home tab 
Opens an analysis document from the Fitted Models  
folder or other location.  

  

Template documents  

A Template document stores the probability model definition. These files are only accessible 
in Develop mode.  Templates are stored in the Model templates folder of the method.  The 
Develop mode user can also manually save and open template documents. 

  

Command  
Where Is 
It?  

Function  

 
  

Develop tab 
Saves a template document to the current method's Model 
Templates  folder. 
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Develop tab 
Opens a template document from the Model Templates  
folder or other location.  
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Phenotype Naming  

  

Each marker for each cell type has a Phenotype field.  The field shows up in the Cell Type 
Wizard and on the Expression Profile properties.  Use this field to describe the marker 
expression for the cell type. 

The recommended syntax for this field is to use the short name of the marker (e.g. CD8), 
with one of the fo llowing appended: 

Symbol    Meaning  

+  plus symbol Positive expression of the marker  

-   minus symbol Negative expression of the marker  

dim  text Dim expression of the marker 

+> - 
plus, greater 
than, minus 

Transition of positive to negative expression of the 
marker 

->+  
minus, greater 
than, plus 

Transition of negative to positive  expression of the 
marker 

  

The values in the Phenotype field are used on report pages to show the full phenotype of a 
cell type.  For example, the CD4 phenotype is shown as "CD4: CD66b-CD3+Cd8-CD4+CD14-
TCRgd-CCR7+>-CD27+>-CD45RA+>-" 
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What is a Probabilit y State Model?  

  

Flow cytometry data analysis focuses on identification of populations in a sample and 
providing statistical results about those populations. Typically, regions drawn on plots are 
used to create a hierarchy of subsets by "gating" the events . The subsets are analyzed for 
frequency, intensity, and other common statistics to characterize the cells that were 
analyzed. 

GemStone approaches data analysis quite differently by using a Probability State Model 
(PSM) to identify and quantify subsets. So what is a Probability State Model, and why is it a 
better approach? 

Let's examine the words that make up the name to get an idea of what a PSM is:  
  

Probability : the statistical likelihood of a particular event occurring. A  PSM classifies events 
using probabilities rather than gates. Gating is subjective, and relatively small errors made in 
drawing gates are compounded with each subsequent gate in the hierarchy. By using 
probability, a PSM actually reduces the error with eac h additional measurement that is added 
to the model. The likelihood that you are actually identifying the cells you are interested in 
increases as you build a PSM. 
  

State : a set of conditions that discretely characterize something. A PSM classifies events into 
a set of states, based on the characteristics defined for each measurement. GemStone uses 
the state as the common, X-axis for its expression plots. This allows all measurements to be 
compared on a common axis, making it possible to correlate all measurements in a single 
plot. 
  

Mod el : a mathematical representation of a process. A PSM uses fitting routines to classify 
cells into the most probable states and cell types. Using this approach, GemStone can 
provide objective assessment of how well the model represents the data. There are no hard-
edges in a PSM. The modeling process allows populations to overlap based on probabilities. 
  
A PSM allows us to classify events into populations based on a model that we define. The 
model is made up of one or more cell types, where each cell type defines a subset that we 
want to analyze. We use what we know about the markers in our experiments to create a set 
of expression profiles for each subset. An expression profile uses a set of control points to 
define how the subset transitions over the state  axis. The state axis is typically labeled 
"Progression", but it does not have to be a progress at all. In fact, simple models can be 
designed to identify and quantify cell populations where the parameter profiles are simply  set 
for constant intensities. 
  
With the PSM approach, we can measure and report confidence limits. We can evaluate the 
goodness-of-fit with reduced chi -square (rcs). And we can co-plot our parameters in a single 
graphic that allows us to examine the coordinated transitions of markers in the cells we 
analyze. 
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Tutorials  

Analyzing Files with an Existing Project  

Overview  

In this tutorial, you will use a previously -created GemStone Project to analyze FCS files from 
a 16-color immune profiling panel. The Project was designed to identify seven cell types and 
to present a report with a summary table and details for each cell type.  

You will add files to this project and analyze them with just a few clicks. The results that you 
see can be reproduced if you or someone else runs the analysis again. The approach is 
simple, fast, and reproducible. 

Let's give it a try!  

  

Start GemStone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a N ew Project  

On the Home tab, click the New Project button to create a new Project. 

 

  

In the New Project dialog, select Example 16 Color  in the Based on  field. This will create a 
new project based on the selected project.  

For Project Name  you can leave the suggested name or type your own. 

Click OK. 

 

  

Add FCS Files  
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Next, you will add files to analyze. Click the Add FCS Files button on the Home tab. 

 

  

In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open . 

 

  

The files are added to the batch list in the left p anel of the program.  

At this point, you are ready to analyze these files automatically with the example 16 -Color 
immune panel project. 

  

Analyze the Files  

The First File  

Let's analyze the first FCS file. 

Click the Run  button in the Processing group on the Home tab. This tells GemStone to follow 
the steps in the batch script to read and analyze the selected file.  
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The software first opens a template document, which defines the analysis for seven cell 
types, along with the plots and report pages. Once the template is opened, the FCS file is 
read into the template.  

The auto-analysis step is next. In this step, each of the defined cell types is adjusted to the 
data in the FCS file. The status pane at the bottom of the main window indicates which step 
of the analysis is being performed. 

 

  

When the process is complete, the summary page of the report presents a table of the key 
results of the analysis.  

 

  

At the bottom of the main window, th ere are tabs for each page in the analysis report. To 
review a page, click the tab.  

 

  

For example, click the CD4 T tab to review the analysis of CD4 T cells. 

The report shows the name of the cell type and its phenotype at the top. The Selection 
Markers section shows several plots for the measurements that were used to identify CD4 T 
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cells, along with a table of intensity values. The Staging Markers section includes plots of 
markers that are used to identify the stages of CD4 T cell development and a tabl e of 
frequencies for each stage. 

 

  

The Rest of the Files  

If you wa nt to analyze and review each file one-by-one, you would use the Next button to 
read and analyze the next file. However, in this tutorial we want to analyz e all of the files 
without intervention.  

Click Auto Advance to process all of the files in the batch.  

 

  

Review the Analysis  
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After analyzing each FCS file, GemStone saves the finished analysis so that it can be 
reviewed later. A PDF of the report is also generated for your records. You can easily re-open 
a saved analysis for the files in the project.  

Double-click the second file in the batch list, 16 -color_2.fcs. A prompt dialog will appear 
offering several choices of actions. 

 

  

Choose Open PDF  to review the PDF report of the analysis. Open GS  will open the analysis 
document associated with the FCS file. Choose Analyze  to re-analyze the file, or Cancel  to 
close the dialog. 

  

Summary  

In this tutorial, you created a new Project based on an existing one designed to analyze the 
16-color tutorial files. You added files to the new project and initiated the analysis of the files 
using the Add , Run , and Auto -Advance  buttons on the Home tab of  the ribbon. 

GemStone automatically adjusted the template document to each of the FCS files, fitting the 
model to the peaks in each file. The analysis included a summary table of key results, along 
with a more detailed page for each of the seven cell types  defined in the template document. 
A PDF and an analysis document was saved for each file. 

You were able to analyze these files with just a few clicks. The approach is simple, fast, and 
reproducible. 
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Analyzing Files with an Existing Project  

Overview  

In th is tutorial, you will use a previously -created GemStone Project to analyze FCS files from 
a 16-color immune profiling panel. The Project was designed to identify seven cell types and 
to present a report with a summary table and details for each cell type.  

You will add files to this project and analyze them with just a few clicks. The results that you 
see can be reproduced if you or someone else runs the analysis again. The approach is 
simple, fast, and reproducible. 

Let's give it a try!  

  

Start GemStone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a New Project  

On the Home tab, click the New Project button to create a new Project. 

 

  

In the New Project dialog, select Example 16 Color  in the Based on  field. This will create a 
new project based on the selected project. 

For Project Name  you can leave the suggested name or type your own. 

Click OK. 

 

  

Add FCS Files  

Next, you will add files to analyze. Click the Add FCS Files button on the Home tab.  
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In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open . 

 

  

The files are added to the batch list in the left panel of the program.  

At this point, you are ready to analyze these files automatically with the example 16 -Color 
immune panel project. 

  

Analyze the Files  

The First File  

Let's analyze the first FCS file. 

Click the Run  button in the Processing group on the Home tab. This tells GemStone to follow 
the steps in the batch script to read and analyze the selected file.  
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The software first opens a template document, which defines the analysis for seven cell 
types, along with the plots and report pages. Once the template is opened, t he FCS file is 
read into the template.  

The auto-analysis step is next. In this step, each of the defined cell types is adjusted to the 
data in the FCS file. The status pane at the bottom of the main window indicates which step 
of the analysis is being performed. 

 

  

When the process is complete, the summary page of the report presents a table of the key 
results of the analysis.  

 

  

At the bottom of the main window, there ar e tabs for each page in the analysis report. To 
review a page, click the tab.  

 

  

For example, click the CD4 T tab to review the analysis of CD4 T cells. 

The report shows the name of the cell type and its phenotype at the top. The Selection 
Markers section shows several plots for the measurements that were used to identify CD4 T 
cells, along with a table of intensity values. The Staging Markers section includes plots of 
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markers that are used to identify the stages of CD4 T cell development and a table of 
frequencies for each stage. 

 

  

The Rest of the Files  

If you want to analyze and review each file one -by-one, you would use the Next button to 
read and analyze the next file. However, in this tutorial we want to analyze all of the files 
without intervention.  

Click Auto Advance to process all of the files in the batch.  

 

  

Review the Analysis  
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After analyzing each FCS file, GemStone saves the finished analysis so that it can be 
reviewed later. A PDF of the report is also generated for your records. You can easily re-open 
a saved analysis for the files in the project.  

Double-click the second file in the batch list, 16 -color_2.fcs. A prompt dialog will appear 
offering several choices of actions. 

 

  

Choose Open PDF  to review the PDF report of the analysis. Open GS  will open the analysis 
document associated with the FCS file. Choose Analyze  to re-analyze the file, or Cancel  to 
close the dialog. 

  

Summary  

In this tutorial, you created a new Pr oject based on an existing one designed to analyze the 
16-color tutorial files. You added files to the new project and initiated the analysis of the files 
using the Add , Run , and Auto -Advance  buttons on the Home tab of  the ribbon. 

GemStone automatically adjusted the template document to each of the FCS files, fitting the 
model to the peaks in each file. The analysis included a summary table of key results, along 
with a more detailed page for each of the seven cell types  defined in the template document. 
A PDF and an analysis document was saved for each file. 

You were able to analyze these files with just a few clicks. The approach is simple, fast, and 
reproducible. 
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Develop: Starting a New Project from Scratch  

  

Overvie w  

Any time you have a new panel to analyze with GemStone, you will create a new Project to 
setup the analysis for the panel. This tutorial shows how to create a new  Project from scratch 
with a model template, a report, and a database of results. You will a lso set up batch options 
that define h ow each FCS file is read and analyzed. 

That sounds like a lot of work, but you will leverage wizards and a streamlined interface to 
make quick work of it.  

  

Start GemStone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Create a New Project  

On the Home tab, click the New Project button to create a new Project. 

 

  

In th e New Project dialog, type "New Project Tutorial" for the name, and then click OK. 

 

  

  

Add FCS Files  
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Next, you will add files to analyze. Click the Add FCS Files button on the Home tab.  

 

  

In the Select FCS Files dialog, navigate to the Tutorials folder of the GemStone 
workspace.  Select the three files 16-color_1.fcs, 16-color_2.fcs, and 16-color_3.fcs. Click 
Open . 

 

  

The files are added to the batch list in the left panel of the program.  

  

Using the Measuremen t Wizard  

When you read files that are new to the program, it's a good idea to read one in and review 
the measurement names and transforms. You can edit the names and transforms with the 
Measurement Wizard. 

Click the Develop  checkbox to enable "Develop mode". This mode exposes additional tools 
that are used to build the Project.  
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On the Develop tab, select the first file in the list and click the Read File button.  This 
command will read the selected FCS file without performing any analysis. 

 

  

Now click the Measurement Wizard button.  This wizard is used to set up the names and 
transformations for the measurements in the FCS files. 

 

  

Click the All  button to select all o f the measurements in the FCS file.   
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Click Next . 

  

The properties for CCR7 are listed, and a histogram of the measurement provides a preview 
of the measurement with the properties applied to it.  

In this dialog, you can edit the measurement name and ab breviation. By default, these will 
display the long name from the FCS file's keywords. You can also edit the transform and its 
properties. 

No changes are needed for CCR7. 
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Click the Next Measurement  button.  

 

  

Review each of the remaining measurements in the same manner. There is only one change 
you will need to make.  

When you reach the Time measurement, set the Transform  to Linear . 
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After setting the Time measurement, click Next  and the Summary page is displayed. 

Enable the Launch Cell Type Wizard  checkbox and then click Finish.  
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Using the Cell Type Wizard  

Now that the program knows about the measur ements and transforms, let's start building the 
analysis using the Cell Type Wizard. This wizard creates or edits the analysis of one cell type 
at a time, one measurement at a time. You will use it to create ju st about everything for 
analyzing this 16-color example. 

If the wizard is not already showing, click the Cell Type Wizard button on the Develop tab.  

 

  

On the Welcome page, choose Create a new cell type  and click Next . 

 

  

On this page, you will give the cell type a name.  

Type  "CD4 T" for the Cell Type Name . 

This page also lets us enable the cell type, pick a color for it, and determine the classification 
type.  For this tutorial, leave these options as they appear and click Next . 
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Next choose the measurements that are used to identify the CD4 T cells. These are called 
Selection Markers.  These can be "positive" markers, as well as markers that are "negative" 
for the cell type.  In this tutorial, you'l l just choose several markers that are positive for CD4 
T cells. 

In the Available Markers list, click each of these markers in this order: SSC-A, CD3, CD4, 
and CD8 

The markers will be removed from the Available Markers list and added to the Selection 
Markers list. 

If the markers are not in the correct order, you can drag the markers in the Selection 
Markers list to reorder them.  
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Click Next . 

On the next page of the wizard, choose the Staging Markers for the CD4 T cells. These are 
markers that change expression levels within the cell type.  They are used to identify 
different stages of CD4 T cells. 

In the Available Markers list, click each of these markers in this order: CCR7, CD45RA , and 
CD27  
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Click Next . 

Next is the Functional and Other Markers page of the wizard. This is where you can pick 
other markers that you want to see in the CD4 T cell type, even if they are not used for 
selection or staging of the cells. Activation markers are a good example of what you would 
pick on this page. 

In th e Available Markers list, click each of these markers in this order: CD25 , CD127 , and 
HLA DR  
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Click Next . 

Now that you have identified the markers to use for the CD 4 T cells, the next task is to set 
up expression profiles for them.  

GemStone uses expression profiles (EPs) instead of gates used in most cytometry analysis 
software. EPs come in different shapes, like constant, step-up, and step-down. They define a 
probability envelope, which does not have hard edges.  

The wizard is showing the first Selection marker, SSC-A, with several properties and an 
unusual dot plot that may not make immediate sense to you.  



Tutorials 

58 

 

  

Here's how to interpret the plot. Think of a typical hi stogram of SSC, as in panel A below. 
Now rotate that histogram 90 degrees (panel B). Now notice that the density of dots in panel 
C matches the peaks in panel B. The Y-axis of the dot plot is SSC-A, and the X-axis (at this 
point) is the order of the events  in the FCS file. There are black triangles on the right edge to 
indicate locations where the program found a peak in the data.  

  

 

  

The CD4 T cells have low SSC-A, and you can see a black triangle that identifies the dimmest 
peak of the SSC-A distribution.  That's the one you want to capture with this expression 
profile. 

Choose Dimmest Peak  for Which Peak . 
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There are several options for the Distribution .  Leave the Distribution set to Normal . 

The Phenotype is automatically updated as you make choices. It should show "SSC-A-" at 
this point.  

The Initial Intensity  is currently set to the location of the peak that you linked the profile 
to. You do not need to change that.  

The Initial Width  is set to the width (SD) of the peak that was found. You don't want this  
expression profile to be quite that restrictive, so you'll make two changes.  

Set Initial Width  to 5  and uncheck Width from Peak .  This will leave the width at an SD 
of 5 and maintain a generous width for SSC-A. 

 

  

Click the Preview  checkbox on the right of the dialog to see what cells will be selected by 
this profile.  
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Click Next Profile . 

CD3 is next. We want the program to find the brightest CD3 peak, and it is already setup that 
way. 

 

  

Click the Preview  checkbox on the right of the dialog to see wh at cells will be selected by 
this profile.  
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Click Next Profile . 

CD4 is set up in the same way, tracking the brightest peak.  You don't have to make any 
changes to this profile. 

 

  

Click Next Profile . 

For CD8, choose Dimmest Peak . 

For the Distribution, select Low Pass . A low pass distribution includes the events below the 
top of the expression profile.  This will capture all of the CD8 negative events. 
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Click Preview  to see the events that a re selected. 

 

  

Click Next Profile . 

Now that you have set up the expression profiles for the selection markers, you are ready for 
the staging markers. For these, you will use profiles that have two or more levels of 
expression. 

CCR7 is expressed on naive CD4 T cells, and it is down-regulated as the cells mature.  The 
StepDown profile is designed for this type of expression. 

NOTE: Depending on your monitor, you may need to resize this dialog to see the options in 
the property list.  

For Expression Profile Sh ape , choose StepDown . 

The other settings will update so that the First Level of the profile tracks the Brightest Peak 
and the Second Level tracks the Dimmest Peak. 
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Enable the Preview  checkbox to see the StepDown profile results. Note that the dots 
representing the cells have been reordered so that the brighter CCR7 events are first and the 
dimmer ones are at the end. As soon as you enable a staging profile like this, the X-axis is no 
longer showing the order of events in the FCS file. Now, the X-axis is showing the 
progression of events, and this order is also enforced in the selection marker plots that you 
setup previously. 
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Click Next Profile . 

You will setup CD45RA in a similar way with a StepDown profile.  

Select StepDown  for the Expression Profile Shape. 

Because there is so much variability in the brighter level of CD45RA, you will set the Initial 
Width  to 10  and uncheck  the Width from Peak  setting. 

 

  

Enable the Preview  checkbox to see the StepDown profile results. 
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Click Next Profile . 

The program thinks there are three levels of expression for CD27, and this may in fact be the 
case. However, unless the levels are very clearly shown, it generally works better to use two 
levels for these distributions with wide variation.  

 

  

Select StepDown  for the Expression Profile Shape. 

Set the Initial Width  to 10  and uncheck  the Width from Peak  setting. 
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Enable the Preview  checkbox to see the StepDown profile results. 

 

  

Click Next Profile . 

Next come the functional makers. For now, skip over these without setting up a profile.  
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Click Next Profile  for CD25. 

The CD127 profile is shown. 

 

  

Click Next Profile  for CD127. 

The HLA DR profile is shown. 
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Click the Summary Page  button.  

A Summary page is shown, allowing you to review the choices made in the wizard. 

Make sure all the checkboxes are enabled, except for Do another cell type. 

 

  

Click Finish . 

Congratulations! You've just created the CD4 T cell type analysis, complete with a report 
page. Your work was saved as a "template model" which can be applied to any FCS files that 
have the same markers and marker names. 
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Review the Cell Type Report  

The wizard created a report page based on the choices you made for each marker.  The page 
includes the current date, the name of the FCS file, and the cell type name and phenotype at 
the top.   

Next, there is a section for  the selection markers.  Each marker is included in at least one dot 
plot. These plots can be changed to show different marker combinations, and you can add 
other plots as well with the tools on the Insert tab.  

On the right is a table listing all of the ma rkers you included in the cell type. For each 
marker, the table shows the median intensity for the whole cell  type as well as for each 
stage. You would need to resize the table to see all of the columns, but leave that for later.  

  

 

  

The next section in the report shows the staging markers. A table summarizing the 
percentages and number of events in each stage appears on the right. The wizard 
automatically determined the four stages of CD4 T cells based on when markers changed 
expression levels. 
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Finally, the other markers are shown, each with an expression profile plot. The footer of the 
report page shows the name of the Project, the page number, and the template model that 
was used for the analysis. 

 

  

The report is well organized and shows the important information from the 
analysis.  However, it is not showing the expression profiles that were set up in t he Cell Type 
wizard. For that you need to switch to a different tab.  

  

Review the CD4 Cell Type  

At the bottom of the program window, click the Cell  Types  tab. The program switches from 
showing the report pages to showing the cell type definitions.  

 

  

On the left of the CD4 T cell type tab is a stack of expression profiles. These are the same 
profile plots that were created in the wizard. There is al so an Overlay Plot, which shows all of 
the markers and stages on a single plot. This is a great plot for seeing how markers up - and 
down-regulate in a coordinated manner. 
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The icon next to the title of eac h expression profile is used to expand or collapse the profile. 

 

  

If you scroll down in the cell type window, you'll find the three staging markers that were set 
up with StepDown profiles. You can see that the first stage (green dots) ends when CD45RA 
has down-regulated. Stage two (orange) ends after CCR7 down-regulates. Stage three (red) 
ends after CD27 down-regulates, and stage four (purple) contains the events that have 
down-regulated for all three markers.  
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Setup the Batch Options  

Now that you have the beginnings of an analysis approach, let's see how to set it up for 
automation.   

You may need to resize the section to see the properties listed. You can also change the 
width of the batch list by adjusting the right edge as shown below.  
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The lower left portion of the screen contains the settings that control batch processing.  

 

  

The first thing the batch should do when analyzing a file is to open the template model that 
you just created with the wizard.  

Choose Open  for the Template  property. 

 

  

Next click the Edit...  button for Open Template Options . 

In the dialog that appears, make sure that Target File  is set to TemplateModel.gs . If not, 
click the folder icon and select the template model to use.  

Click OK. 
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In the Analysis section, enable Auto Analyze Data . This tells the program to auto analyze 
the FCS file with the template model. 

 

  

Once the analysis is complete, the Finish Up section determines what kinds of output to 
generate. 

Enable the Save Document  and Save PDFs  properties. 

 

  

Now you're ready to save these changes.  Before you do, let's make sure that the template 
model is showing the Report  tab and the CD4 T report page. This will be the view you see 
when the analysis completes.  
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Click the Save Project button in the upper left of the Develop tab of the ribbon bar.  

 

  

When prompted to save the model template, click Yes. 

 

  

You now have created the model and defined the batch process. 

  

Try it out!  

Let's see if everything works as expected. 

Right-click the first file in the batch list and choose Start Here  from the context menu.  

 

  

On the Home tab, click the Auto Advance button. This tells the program to analyze all of the 
files in the batch without intervention.  
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Our template model is pretty simple at this point, so the analysis will be quick.  Once it has 
completed, you can review the results by scrolling horizontally in the batch list.  

 

  

If you want to review one of the analyzed files, dou ble -click  the file in  the list. The program 
will ask what you want to do: open the PDF, open the saved analysis (Open GS), redo the 
analysis (Analyze), or cancel the dialog. 

Choose Open PDF  to view the report in PDF format. Note, at this point the first pa ge in the 
report will  be blank. We will use this blank page as a summary page in later tutorials.  

  

 

  

Double-click the file again, and this time choose Open GS . This will open the finished 
analysis of the file. With this, you can make manual changes and review the details of  each 
cell type. This is especially useful when creating new template models or trying to determine 
the cause of a problem. 



GemStone User Guide 

77 

 

  

Summary  

In this tutorial you started a new project from scratch. You gave friendly names to the 
measurements and used the Cell Type wizard to create one cell type for CD4 T cells. In the 
process, you looked at the different ways to setup expression profiles and a few caveats. The 
wizard created a template model from our choices and a report page with plots and tables of 
statistics.  

You learned how to set up the batch options to process a set of files through the template 
model, and then you tested it out by analyzing all of the files added to the project.  

One thing to keep in mind is that you will not always ha ve to start from scra tch. You can 
reuse the template model for other files that were acquired with the same panel. If you 
extend that panel with additional markers, you can create a new Project based on this one so 
that you only need to define the new port ions of the analysis. 

The tutorials that follow will build upon what you have created in this one.  
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Develop: Adding Cell Types to the Project  

  

Overview  

In the previous tutorial, Starting a New Project from Scratch, you set up the analysis of CD4 
T cells and ended up with a nice report and database of results. 

In this tutorial, you will add two more cell types to the analysis: CD8 T and NK cell types. You 
will use the Cell Type Wizard to add a cell type and test each cell type before moving on to 
the next one. This iterative process is the recommended approach, as it tests each 
enhancement incrementally. 

  

Prerequisites  

This tutorial continues to build the Project that was started in the following tutorial:  

Develop: Starting a New Project from Scratch 

  

Start GemStone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project  

Open the "New Project Tutorial" Project that you created in the previous tutorial by selecting 
it in the Project dropdown list.  

 

  

Click the Develop  checkbox to enable develop mode. 

 

  

Open the Template  
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On the Develop tab, click the Open Template button.  

 

  

Select "TemplateModel.gs" in the Open GemStone Document dialog and click Open. 

 

  

Click the first file in the list, and then read the FCS file by clicking the Read File button. This 
will read the file into the template without auto -analyzing it. 

 

  

Cell Type Wizard for CD8 Cell Type  

Click the Cell Type Wizard button to start the wizard.  
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In the Cell Type Wizard dialog, select Create a new cell type  and click Next . 

 

  

For the Cell Type Name enter "CD8 T " and click Next . 
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Selection Markers  

In the Available Markers list, click each of these markers in order: SSC-A, CD3, CD4, and 
CD8. The markers will be added to the Selection Markers list. 
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Click Next . 

  

Staging Markers  

In the Available Markers list, click each of these markers in order: CCR7 and CD27 . The 
markers will be added to the Staging Markers list. 
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Click Next . 

  

Functional and Other Markers  

In t he Available Markers list, click each of these markers in order: CD38  and HLA DR . The 
markers will be added to the Functional Markers list. 
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Click Next . 

  

Selection Marker Expression Profiles for CD8  

SSC-A is the first selection marker, and you will use  a new technique to set up its expression 
profile. When you setup the CD4 T cell type, you tracked the dimmest peak of SSC-A. That's 
what we want to do for the CD8 T cell type, too. When two cell types set up a marker in the 
same way, you can "link" them t ogether. Linking expression profiles speeds up the analysis 
and ensures consistency in how the profiles are set up. 

Click the Links  button.  
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In the menu of choices, choose CD4 T: SSC-A.  

 

  

When the link is made, the properties for the CD8 T SSC-A measurement are set by the CD4 
marker in the CD4 cell type. The profile switches into Preview mode automatically. 
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Click Next  Profile . 

Use the same technique for CD3.   

Click the Links  button and select the "CD4 T: CD3" profile.  

 

  

Again, after the link is  made the profile switches to Preview mode. 
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Click Next  Profile . 

For the CD4 marker in the CD8 T cell type, select Dimmest Peak and Low Pass . As we saw 
earlier, the Low Pass profile captures events that are below the top of the expression profile..  

 

  

Click Next  Profile . 

For CD8 we are interested in the dim to bright CD8 events. Let's learn another trick to 
capture these events. 

Click the Links  button.  
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In the menu, select "CD4 T: CD8". 

 

  

This may seem like a mistake at first, because the CD8 expression in the CD4 T cell type is 
not the expression level for the CD8 T cell type. In fact, it is the opposite. For the CD8 T cell 
type the cells of interest have dim to bright expression of CD8.  

Change the Distribution to Inverse Low Pass . The Inverse Low Pass distribution selects the 
events above the top of the profile, which are the dim to bright events.  

 

  

Click Next  Profile . 



GemStone User Guide 

89 

  

Staging Marker Expression Profiles for CD8  

Moving on to the staging markers for the CD8 T cell type, the first is CCR7. This marker is 
abundant on early CD8 T cells, and is lost as they mature. 

Select StepDown  for the Expression Profile Shape. 

 

  

Enable the Preview  checkbox to see how the StepDown profile fits the two le vels of 
expression for CCR7. 
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Click Next  Profile . 

The program suggests a ThreeLevels profile shape for CD27 because it detects three levels of 
expression. There may indeed be three levels of expression, but they are not clearly 
distinguishable in this data. We will choose a simpler profile shape. 
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Select Step Down  for the Expression Profile Shape. For the Initial Width  type 10.00  and 
uncheck Width from Peak . Using a larger, fixed width for the bright peak will allow the 
program to capture the two appar ent levels of bright expression. 

 

  

Enable the Preview  checkbox. Notice that even with the StepDown profile, we can 
appreciate three levels of expression in CD27. 

 

  

Click Next  Profile . 

  

Functional Marker Expression Profiles for CD8  
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Next come the functional makers. For now, skip over these without setting up a p rofile. 

 

  

Click Next Profile  to skip CD38. 

The HLA DR profile is shown. 
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Click Summary Page  to skip HLA DR. 

On the Summary page, review the summary information for the cell type. Make s ure that 
Save template model , Update summary map , Add to Cen -se' , and Add database 
fields  checkboxes are enabled. 

 

  

Click Finish . 

After the wizard closes, the changes you made to the model template will be saved and the 
wizard-created report page for CD8 will be displayed. 

  

Review the CD8 Report  

As we saw previously, the report page is divided into sections for Selection Markers, Staging 
Markers, and Other Markers. Plots in each section display the measurements that we added 
to the cell type. Tables are included to show median intensities for the markers and 
frequency information for the stages.  
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Test the Analysis with CD8 T and CD4 T  

Each time a cell type is added or revised you should check how the new cell type affects 
other cell types in the model template.   
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The idea is to review each of the other cell t ypes to make sure that nothing has changed 
dramatically. 

Click the Run button at the bottom of the batch list. This has the same function as the Run 
button on the Home tab, running the batch commands to process the selected  FCS file. 

  

 

  

When prompted, choose Analyze  to re-run the analysis of this FCS file with the modified 
template. 

 

  

When the analysis is complete, select the CD4 T cell type page of the report by clicking the 
CD4 T tab at the bottom of the report pages.  The distributions in the CD4 T cell type are 
almost identical to what they were with the original model template. This suggests that 
adding the CD8 T cell type did not adversely affect the CD4 T cell type. 
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Excellent.  Let's move on to the next cell ty pe. 

  

Cell Type Wizard for NK Cell Type  

The NK cell type is a very simple one, so let's add that one now. 

Click the Cell Type Wizard button. 
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Choose Create a new cell type  and click Next . 

 

  

Type "NK"  for t he Cell Type Name and click Next .  
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Add three selection markers in order: CD3, CD56 , and CD14 . 
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Click Next . 

This cell type will not have any staging or functional markers. 

Skip Staging and Functional by clicking Next  for each of these pages. 

  

NK Sel ection Marker Expression Profiles  

For CD3, choose Dimmest Peak  and Low Pass . 
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Click Next Profile .  

For CD56 we want the dim to bright events. The best way to capture them is with an Inverse 
Low Pass profile. 

Choose Dimmest Peak  and Inverse Low Pass . 

Since the dim peak has a very small width, let's manually adjust the width so that we don't 
include the dimmest CD56 events. 

Set the Initial Width  to 5.0  and uncheck Width from Peak . 
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Enable the Preview  checkbox to verify that the dim to bright events are selected. 

 

  

Click Next Profile . 

For CD14, choose Dimmest Peak  and Low Pass .ac 
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Enable the Preview  checkbox to verify the selection. 

 

  

Click Summary Page .  

Review the cell type wizard summary and click Finish . 
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The report page for the NK cell type is very simple, with just the three selection markers.  
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Test the Training Set with the Three Cell Type Model Template  

The model template now has three cell types: CD4 T, CD8 T, and NK.  Let's test it out by 
running the batch of FCS files in our training set.  We'll review the reports for each of these 
to verify that all cell types are workin g properly. 

Right-click the first file in the batch list and choose Start Here . 

 

  

Click the Auto Advance button to autom atically process all three files in the batch. 

 

  

When the batch is finished, you can review the results by scrolling horizontally in the batch 
list, the part of the window where the files are listed.  You can change the width of the batch 
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list by adjusting the right edge as shown below. Result for all three cell types will appear in 
the database. 

 

  

If you want to perform additional statistical analysis on the results in another program, you 
would right -click on the batch list and choose Export Database. This option displays a file 
save dialog and allows you to save the database in tab-delimited format, which can be 
imported into spreadsheets, word processors, and lab information systems. 

 

  

You can compare the report PDFs for each of the files. Double -click  the file in the list. The 
program will ask what you want to do: open the PDF, open the saved analysis (Open GS), 
redo the analysis (Analyze), or cancel the dialog. 

Choose Open PDF  to view the report in PDF f ormat. Note, at this point the first page in the 
report will be blank.  

Repeat this for each of the files in the batch list.  
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Summary  

In this tutorial you extended the model template by adding two more cell types: CD8 T and 
NK. You learned how to link expression profiles from one cell type to another. Linking profiles 
helps to speed up the processing and makes the model template more consistent and robust. 

We introduced the use of Inverse Low Pass distributions for capturing the dim to bright 
distribution of the CD8 marker.  

In the next tutorial you will learn how to analyze subsets in a cell type. 
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Develop: Analyzing Subsets  

  

Overview  

In this tutorial, you will learn how to extract information about subsets within a cell type. We 
use the term "subset" to refer to a group of cells within a cell type that have some common 
attributes, but t hey do not necessarily fall into a particular stage of development.  

A good example of a subset is the Treg subset of CD4 T cells. These cells are positive for 
CD25, negative for CD127, and they can occur in any stage of CD4 T cells. 

In this tutorial you w ill add to the Project we developed in the previous tutorials, Starting a 
New Project from Scratch and Adding Cell Types to the Project. You will add a TriCOM object 
to quantify cells that are CD25+CD127- and add a table to the report to show Treg statistics.  

  

Prerequisites  

This tutorial continues to build the Pr oject that was started in the following tutorials:  

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

  

Start Gem Stone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project  

Open the "New Project Tutorial" Project that you created in the previous tutor ials by selecting 
it in the Project dropdown list.  

 

  

Click the Develop  checkbox to enable develop mode. 
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Open a Saved Analysis Document  

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Open GS  to open the saved analysis for the file. 

 

  

  

  

Edit the Cell Type with the Cell Type Wizard  

Next we need to make several edits with the Cell Type wizard. These edits will allow us to 
define the Treg subset of CD4 T cells. 

Click the Cell Type Wizard  button to initiate the wizard. 

 

  

This time you will use the wizard to edit the CD4 T cell type.  
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Click the Edit the selected cell type  option and select CD4 T from the list of choices and 
click Next.  

 

  

We only need to edit the Functional markers, so we can skip past a number of pages in the 
wizard: 

Click Next  on the Cell Type Properties page. 

Click Next  on the Selection Markers page. 

Click Next  on the Staging Markers page. 

Click Next  on the Functional Markers page. 

  

Most of the expression profiles do not need any edits:  

Click Next Profile  on the Profiles pages for SSC-A, CD3, CD4, CD8, CCR7, CD45RA , and 
CD27 . 

  

Set up the Functional Profiles  
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For CD25, set up the expression profile with the following:  

Choose Constant  for the shape and Dimmest Peak  for the peak.  

 

  

Enable the Preview  checkbox to try out these settings.  

Note the heavy black line above the expression profile.  These identify the 95% confidence 
limits of the profile. Events that are above the top line have a low probability of being 
included in the profile. They are the events that will be considered "high" for CD25 as we 
define the Treg events. 

If you wanted to include fewer events in the profile, you would make the Initial Width smaller 
and uncheck Width from Peak.  Similarly, to include more events, you would make the Initial 
Width larger.  
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Click Next Profile . 

For CD127, set up the expression profile with the following:  

Choose Constant  for the shape and Brightest Peak  for the peak.  

Set the Initial Width  to 8.0 and uncheck the Width from Peak  option. 

  

 

  

Enable the Preview  checkbox. 

The Initial Width of 8 puts the lower side of the 95% confidence limit in a good position to 
separate positives and negatives. Events within the confidence boundaries will be considered 
"positive" for CD127, and those that fall  below the lower boundary will be considered 
"negative" for CD127. 
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Click Next Profile . 

Skip over the HLA DR  profile for the time being. Click Summary Page . 

Review the summary information.  Make sure that Save template model  and Update 
summary map  options are checked. 

Click Finish  to close the wizard and save your changes. 

 

  

  

What is a TriCOM?  
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TriCOM is the tool that can identify subsets within a cell type. As its name implies, TriCOM 
can compute three states for the combination of measurements that we add to it. The three 
stats identify whether an event is within the 95% confidence limits of th e expression profile 
(normal), below the lower confidence limit (low), or above the upper confidence limit (high).  

 

  

In some cases, you may only be interested in whether the expression is high, as with CD25 in 
this tutorial. In other cases, only the low  expression is of interest.  TriCOMs can be set up for 
High-Only and Low-Only to accommodate these cases. 

  

Here is an example that uses a High-Only TriCOM to quantify activated CD4 T cells. In the 
illustration, there are two expression profiles on the lef t, one for HLA DR and the other for 
CD38. These are activation markers for CD4 T cells. The plots show the high (H) and normal 
(N) expression levels. Also note that there are two stages: naive CD4 T cells are dark blue 
dots and memory cells are orange dots. A cartoon of a TriCOM is shown on the right.  The 
bottom row of the TriCOM would show events that are in the normal 95% confidence limits, 
however this TriCOM is set up to show high events only. The next row up from the bottom 
quantifies events that are high for either HLA DR or CD38, but not both. For example, there 
are 2200 events that are high for HLA DR in the naive stage and 7000 events high for HLA 
DR in the memory stage. The top row contains events that are high for both HLA DR and 
CD38.  
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Let's create a TriCOM to see how it works. 

  

Create a TriCOM  

On the Insert  tab of the ribbon, click the TriCOM button. There is also a TriCOM button on 
the cell type toolbar on the left edge of the Cell Type window.  

 

  

Scroll  to find an empty place on the CD4 cell type, then  click and drag  to define the 
TriCOM location. A TriCOM with default measurements is created. 
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Right-click in the TriCOM and choose Edit Graphics  from the context menu.  

 

  

Find the Measurements  section of the dialog and click the Choose  button.  
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Uncheck  the SSC-A, CD3, and CD4 measurements Include property. 

Check  the CD25  and CD127  Include property.  

Select High Only  for CD25  and select Low Only  for CD127 .   

 

  

Click OK. 
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Click OK to close the Edit Graphic Options dialog. 

The TriCOM for CD25 and CD127 is displayed. 

 

The TriCOM is divided into four vertical sections, one for each of the stages.  The Y-axis 
shows the number of measurements that are outside the expression profiles.  Each element 
in row one has one measurement outside the expected expression level, while row two has 
two measurements outside the expression profile. The key at the bottom indic ates that A is 
CD25 and B is CD127.  An uppercase letter indicates elevated expression, and a lowercase 
letter indicates low expression.   

Notice the largest pie on the bottom row. All of the cells in this pie are in the Stg2  stage of 
the progression.  The A wedge represents cells that have elevated CD25 and normal, positive 
expression of CD127. The b wedge represents cells that have low expression of CD127 and 
normal, low expression of CD25.  

Pies on the second row have the phenotype Ab , which corresponds to CD25+ CD127-. This 
is Treg phenotype. The size of the pies is proportional to percentage, so Stg2  contains the 
largest fraction of the Tregs.  

  

Naming Stages  

Even though we will not rename the stages in this tutorial, it is useful to know that 
GemStone allows you to rename stages from the default stage names of Stg1, Stg2, etc. Th e 
Stages command on the Develop tab is used for this purpose. Some of the elements on 
reports need to be updated after stages are renamed, and the easiest way to update them is 
to use the Cell Type Wizard to edit the cell type and create a new report page.  

We will leave that for another tutorial.   
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Verify a TriCOM with Animation  

We can use animation to verify the Treg events. Anim ation will blink events in all of the plots 
for the pie segment that we select.  

Right-click the pie for Ab  events in the Stg1  stage and choose Edit Segment . 

Note: your statistics may differ from those shown in the images below.  

 

  

In the Animation section , choose a bright color like pink and enable the Animate  checkbox. 
Scroll the cell type window with this dialog open. Open the CD25 and CD127 profiles. Note 
the events blinking in the expression profile plots are CD25+ CD127- in Stg1.  

 

  

Uncheck  the Anim ate  checkbox and click OK to close the dialog. 

Right-click the large Ab  pie on the upper row in Stg2  and choose Edit Segment . 

Choose a bright color and enable the Animate  checkbox. 

Again the CD25+ CD127- events are blinking, this time in Stg2.  
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Animation makes it easy to verify the TriCOM segments. 

Uncheck  the Animate  checkbox and click OK to close the dialog. 

  

Create a Table  

Let's create a table under the TriCOM to show the percentages for the Tregs in each stage, 
as well as the total percentage of Tregs. 

Click the Table  tool on the Cell Type toolbar or on the Insert tab of the ribbon.  

 

  

Below the TriCOM you just created, click and drag  to define space for a table. 
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Right-click just above the table's grid and choose Edit Frame  in the menu.  

 

  

Edit the Rows  to 5  and Columns  to 2.   

Click OK. 
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In the first column, type the following text labels:  

Naive Tregs , CM Tregs , EM Tregs , TE Tregs , and Total Tregs . 

 

  

Next you will add information fields that contain the percentages for the Treg subset.  

Left-click the cell next to Naive Tregs , then right -click that cell. 
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The Edit Selected Information Units dialog is displayed. This dialog contains all of the 
information that GemStone has computed for this model template and FCS file, including the 
TriCOM information.  

Note, you may need to resize this dialog and adjust column widths on some monitors to see 
the information presented below.  

Scroll to the section labelled CellType1_TriCOMGraph  and click the arrow next to the label 
to open the section. 

 

  

Select the item n amed CellType1_TriCOMGraph_Stg1_A+b -_PercentCellType  and 
click the Add  button. The statistic is added to the list on the left of the dialog.  
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Scroll down in the list and select CellType1_TriCOMGraph_Stg2_A+b -
_PercentCellType . Click Add  to add it to the list on the left.  

 

  

Next select CellType1_TriCOMGraph_Stg3_A+b -_PercentCellType  and click Add . 
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Select CellType1_TriCOMGraph_Stg4_A+b -_PercentCellType  and click Add . 

 

  

Scroll back up to the CT total section and add the 
CellType1_TriCOM Graph_CTTotal_ A+b -_PercentCellType . 
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With these five statistics added to the list on the left, click OK. 

The fields we picked fill down from the selected cell, and the five results are added to the 
table. You may need to tab out of the first cell to see  the value. 

 

You can create tables on a report page using the same technique. 

  

Save your Work  

At this point you have a TriCOM for Tregs in the CD4 T cell type and a table to display the 
results. This is the approach used to quantify subsets within a cell  type. 

  

Before saving, switch back to the Report tab, display the CD4 T report page, and scroll it to 
the position you want to appear when this template is used.  The template will remember 
this view when it is saved.  Click Save  in the Template section of the rib bon.   
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Summary  

This tutorial introduced the TriCOM object, which you used to identify the Tregs subset of 
CD4 T cells. TriCOMs are associated with functional markers and identify elevated and 
diminished levels of expression. The Tregs TriCOM quantified high CD25 and low CD127 
expression. 

You animated segments of the TriCOM to see where the associated events appear in other 
plots. This technique was used to verify that the TriCOM was working correctly.  

Once the TriCOM was created you created a table, added some text labels to it, and then 
selected the results to display in the table.  

The next tutorial introduces the Cen-se' plot and how it is used to explore your data.  
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Develop: Exploring with Cen -se'  

  

Overview  

GemStone has two independent analysis systems. In the previous tutorials, you have worked 
with the Probability State Modeling (PSM) system to analyze the FCS files. Cen-se' is the 
second system, which can make use of PSM information to color and label cell type 
information.  

Cen-se' is a fantastic tool for exploring your data. It statistically determines related events 
based on the measurements we select, and presents them in a bivariate plot. With Cen-se', 
we can assess how well our model is identifying cells in our cell types. We can also explore 
cells that do not yet belong to a cell type to find out what measurements identify them.  

In this tutorial we extend the Project developed in the previous tutorials, Starting a New 
Project from Scratch, Adding Cell Types to the Project, and Analyzing Subsets. We add a 
Cen-se' plot to a report page and used to explore our data.  

  

Prerequisites  

This tutorial continues to build the Project that was started in the following tutorials:  

Develop: Starting a New Project from Scratch 

Develop: Adding Cell Types to the Project 

Develop: Analyzing Subsets 

  

Start GemStone  

Start Gemstone by following the instructions in the Installation and Setup of GemStone 
section. 

  

Open the Project  

Open the "New Project Tutorial" Project that you created in the previous tutorials by selecting 
it in the Project dropdown list.  
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Click the Develop  checkbox to enable develop mode. 

 

  

Analyze a File  

Double-click the first file in the batch list.  A dialog of choices will be displayed. 

Click Analyze  to reanalyze the file with the latest model template revisions.  

 

  

  

Adding a Cen -se' Page and Plot  

Click the Add Page  button on the Report tab next to th e NK cell type. This will create a new 
page for the report.  

 

  

Right-click the new page and choose Rename .  
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Edit the name to Cen-se and press Enter. 

 

  

Select the Cen-se' tool on the report toolbar or from the Insert tab of the rib bon. 

 

  

Click and drag to define space for a Cen-se' plot on the report page.  
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Double-click in the new Cen-se plot to display the Edit Graphics Options  dialog. 

Click the Choose  button for Measurements . 
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In the Choose Measurements dialog, enable all of the measurements except for FSC-H, 
SSC-H, and Time . We exclude these because FSC-A and SSC-A provide more information for 
the Cen-se, and Time does not help the Cen-se differentiate cell types. 

Click OK. 
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Click the Choose  button for Cell Types . 
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Make sure that all cell types are selected except for Other Events . 

Click OK. 
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Click OK to close the Edit Graphic Options dialog. 

Move the mouse over the Cen-se plot to show its toolbar, then click the Build Cen-se'  tool. 
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After a few moments, the Cen-se' plot will be displayed. The plot is a two -dimensional 
representation of the 21 measurements we selected in previous steps. Based on the popular 
t-SNE embedding algorithm (t-SNE © 2014 Laurens van der Maaten, Delft University of 
Technology), Cen-se' provides better separation of populations and computes much faster 
than t -SNE. 

Notice that some of the populations are labeled with the cell type and stages created with 
the Cell Type wizard. This labeling is applied automatically for any of the cell types t hat we 
include in the Cen-se'. The coloring of the populations comes from the stage colors in this 
initial view of the plot. The gray dots represent populations that have not been defined in the 
template model yet. 

Note, your graphics and statistics may differ from those shown below.  

 

  

Using the Intensity Heatmap  

The CD4 T, CD8 T, and NK cell types are labeled, and the coloring from the cell types is 
applied to the events in the Cen-se' plot. There are also several populations of gray-colored 
events. 

  

Double-click the plot to display the Edit Graphic Options  dialog again. Move and size the 
dialog so that you can see the Cen-se' plot. Click the Cen-se'  tab of the dialog.  
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In the Coloring section, change Color Scheme  to Intensity Heatmap .  

Select CCR7 for the Heatmap Measurement.  The Naive (Stg1) CD4 T and CD8 T cells are 
brightest for CCR7, as shown with red dots. Events that do not express CCR7 are shown as 
dark blue dots. The intensity color scale is shown on the right -hand side of the Cen-se' plot. 

 

  

Change the Heatmap Measurement to CD3. 

With CD3 selected, the CD4 T and CD8 T cell type show bright red dots. 
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Select CD14  for the Heatmap Measurement. 

One population is red, probably the monocytes. 

 

  

Select CD16  for the Heatmap Measurement. 

The CD16 events are likely neutrophils, which would explain the large fraction of events in 
this population. 

 

  

Select CD19  for the Heatmap Measurement. 

One of the CD19 positive populations is probably B cells. 
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The Intensity Heatmap is a great way to explor e and verify populations in the Cen-se plot. 

Set Color Scheme  back to Summary Map Colors , and click OK. 

  

Exploring Unknowns with Cen -se'  

We have seen how colors and labels from the template model can enhance the Cen-se' plot. 
We can also use the Cen-se' plot to explore populations in the template model. This tight 
integration of Cen-se' and the Probability State Model is unique to GemStone and may be one 
of its most powerful features . Let's try it out.  

Select the Ellipse Region  tool in the Cen-se toolbar on the right side of the Cen -se plot. 

 

  

Draw an elliptical region around the population we identified as CD14+.  
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Right-click inside the region and choose Show Region Animation . 

  

 

  

Click the Cell Types  tab and select the Other Events  cell type. 
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The Other Events cell type displays events that are not included in any of the other cell types 
defined in the model template.  

You may need to scroll the cell type window so that you can see the upper left corner. 

Right-click the first plot and choose Expan d This Plot . 

 

  

The dots that are blinking are the ones you surrounded on the Cen-se plot with the region. 
You can see that CCR7 is negative to dim for those events. 

Use the Page Do wn  key (PgDn) on the keyboard to view the next measurement, 
CD3.  Most of the blinking events are negative for CD3. 



GemStone User Guide 

141 

 

  

Page down until you find CD14 . Note that most of the blinking events are positive for CD14.  



Tutorials 

142 

 

  

Page down until you come to CD38 .  Notice that it is also positive. 
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Page down to HLA DR . Note that this marker  is positive for the animating events.  
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The phenotype of these blinking events, CD3- CD14+ CD38+ HLA DR+, points to this 
population being the monocytes. Using this information, you could use the Cell Type Wizard 
to create a new cell type for monocytes.  

Return to the Cen-se' plot by selecting the Reports  tab and choosing the Cen-se page. 

Move  the region to the smaller population near the monoc ytes. This was CD19+ in the 
Intensity Heatmap, so it may be the B cell population.  
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Return to the Other Event s cell type by selecting the Cell Types  tab and choosing Other 
Events . 

Find CD38  and use the Expand This Plot  command. 

Note that all intensities of CD38 are blinking. Naive B cells express CD38, and CD38 is down-
regulated as B cells mature. 
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Expand the CD19  expression profile.  

Consistent with B cells, the bright CD19 events are blinking, along with some dim CD19 
events.   
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Finally, expand the HLA DR  plot and notice the bright HLA DR events are animating.  This 
confirms that this is the B cell populatio n. 

 

  

Back on the Cen-se plot, right -click the R1  region and choose Show Region Animation  
again to toggle the animation off.  

 

  

Using region animation, you can identify the key markers for unknown events that cluster 
together in Cen-se'.  Often the markers will point to a known cell type that has not yet been 
created in the template model.  

  

Save your Work  

It is time to save the enhancem ents to our model template. Before saving, switch back to the 
Report tab, display the CD4 T report page, and scroll it t o the position you want to appear 
when this template is used.  The template will remember this view when it is saved.   

Click Save  in the Template section of the Develop tab on the ribbon.   










































































































































































































































































































































































































































































































































































































































































































































